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Version 13
Aktualisieren von vorherigen Versionen

1. Alle Plattformen (Pulte und PC-Suite):

Ab Version 12.0 ist generell ein AvoKey Dongle erforderlich. Dieser kann bei
Avolites bzw. dem jeweiligen Avolites-Vertrieb erworben werden. Bei Pulten,
die nach dem 01.06.2019 gekauft wurden, ist der AvoKey bereits eingebaut
bzw. wird mitgeliefert. Ist der AvoKey nicht bereits ab Werk eingebaut, so
muss er einmalig lizenziert sowie mit dem korrekten USB-Anschluss verbun-
den werden (siehe Installationsanweisungen). Genaue Hinweise dazu gibt es
auf der englischen sowie der deutschen Avolites-Website.

2. alle Pulte ab Version 12.0:

Bevor an der Software Anderungen - wie etwa ein Upgrade - vorgenommen
werden, sichern Sie zunachst Ihre Shows und ggf. weitere Daten (Personali-
ties etc.). Es steht ein weitgehend automatisierter Upgrade-Mechanismus zur
Verfligung. Die daflir erforderlichen Daten kénnen Sie von
http://www.avolites.com/software/latest-version herunterladen. Speichern
Sie dieses im Stammverzeichnis eines USB-Sticks. Version 13.0 gibt es als
kleines Upgrade-Installationspaket, welches einfach auf die bestehende Soft-
ware installiert wird (Tools »>Additional Programs ->Titan Installers). Dabei ist
keine neue Lizenzierung erforderlich. Verfolgen Sie aufmerksam die Meldun-
gen des Installers. Zum Abschluss ist ein Neustart erforderlich. Uberpriifen
Sie im System-Menl, dass nun die aktualisierte Version gestartet wurde.

3. PC, alle Versionen (fiir Titan One, Simulator und Titan Mobile):

Vorausgesetzt werden nun 64-bit Versionen von Windows 10 (empfohlen),
Windows 8.1 oder Windows 7. Das betrifft Titan Go, Titan Mobile, den Titan
Simulator sowie den Personality Builder.

Sichern Sie zunachst Ihre Shows und Personalities, bevor Sie mit dem Up-
grade beginnen. Das Upgrade ist wie von anderen Programmen gewohnt zu
installieren: laden Sie das Paket Titan PC Suite von
http://www.avolites.com/software/latest-version herunter, schlieBen Sie die
Pult-Software (wenn nicht bereits geschehen), starten Sie per Doppelklick
das Installationsprogramm, und folgen Sie den Anweisungen. Nach erfolgter
Installation muss der Computer neu gestartet werden. Zur Lizenzierung ist
nun ein AvoKey erforderlich (s.0.), der mit einem USB-Anschluss des Compu-
ters verbunden sein muss. Beim ersten Programmestart 6ffnet sich der Au-
thenticator; folgen Sie den Anweisungen, um die Software zu lizenzieren.

Dies ist die letzte Titan-Version, die noch Windows 7 unterstitzt. Es wird
empfohlen, bei nachster Gelegenheit auf Windows 10 umzusteigen.

4. Titan Remote:

Bitte laden Sie die App Titan Remote V13 aus Ihrem App-Store herunter und
installieren Sie diese wie gewohnt. Altere Remote-Apps arbeiten weiterhin
mit alteren Titan-Versionen zusammen. Nutzer der Android-App beachten bit-
te die Hinweise weiter unten.


http://www.avolites.com/avokey
http://www.avolites.de/lichtpulte/avokey
http://www.avolites.com/software/latest-version
http://www.avolites.com/software/latest-version
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Neue Features:

1. Playback-Gruppen

Es gibt das neue Feature ‘Playback-Gruppen’. Damit lassen sich Gruppen von
Playbacks definieren, innerhalb deren jeweils nur ein Playback aktiv sein
kann: wird ein Playback gestartet, so werden alle anderen Playbacks in der
Gruppe deaktiviert.

Im Gruppen-Meni (erreichbar mit der <Group>-Taste) gibt es einen neuen
Menueintrag [Playback Groups]. Wahlt man diesen, so 6ffnet sich das Menii
,Playback Groups', in dem man diese Gruppen anlegen und editieren kann.

[Record playback group] 6ffnet das Menl 'Record Playback Group', in dem
man Playbacks auswahlt, die zu einer Gruppe zusammengefasst werden sol-
len. Mit [Legend =] kann fiir die Gruppe eine Bezeichnung vergeben werden
(wird keine vergeben, so heiBt die Gruppe ,Playback Group {user humber}).
Die Benutzernummer wird automatisch auf die ndachste freie Nummer ge-
setzt, kann aber mit [User Number] auch manuell vergeben werden. Ist die
eingegebene Nummer noch frei und klickt man auf [Store] oder <Enter>, so
wird eine neue Playback-Gruppe erstellt. Ist diese Nummer dagegen schon in
Verwendung, so kann man entweder mit [Merge] die ausgewahlten Playbacks
der Gruppe hinzufiigen (dabei bleibt die Legende der Gruppe erhalten), oder
aber mit [Replace] die alte durch die neue Gruppe ersetzen (sowohl bezliglich
der Playbacks als auch der Legende).

[Edit playback group] oder <Enter> (wenn im ‘Playback Groups’-Men( die
Nummer einer existierenden Gruppe angegeben ist) 6ffnet das Men( ,Edit
Playback Group', wobei alle aktuell in der Gruppe vorhandenen Playbacks
markiert werden. Will man eine andere Gruppe editieren, so gibt man einfach
eine andere Nummer ein. Durch An- und Abwahlen kann man die der Gruppe
zugehorigen Playbacks andern, und mit [Legend=] lasst sich die Legende edi-
tieren. Um die Playback-Gruppe zu ldschen, drickt man auf [Delete] und be-
statigt das mit [Delete playback group x] oder <Enter>; mit [Cancel] lasst
sich der Léschvorgang abbrechen. [Renumber] 6ffnet das ,Renumber Play-
back Group' Mend, in dem man die Benutzernummer der Playback-Gruppe
andern kann. Ist die neue Nummer noch frei, so wird diese mit [Renumber]
oder <Enter> Gbernommen. Ist die Nummer dagegen bereits in Verwendung,
so kdnnen mit [Swap user humbers] oder <Enter> die Nummern der Grup-
pen getauscht werden.

Weiter gibt es ein neues Fenster ‘Playback Groups'. Hier sieht man auf einen
Blick alle angelegten Playback-Gruppen, kann neue anlegen und bestehende
editieren. Wie gewohnt erreicht man dies iber das Menl [Open Workspace
Window] (Fenster 6ffnen), gefolgt von [Playback Groups], oder Uber <View>
[Open Workspace Window] [Playback Groups], oder Gber <Group> [Playback
Groups] [View All].

Das Fenster ‘Playback Groups’ zeigt auf der linken Seite alle bestehenden
Playback-Gruppen. Ist rechts unten der Reiter ,Playbacks' aktiv, so werden
rechts oben alle Playbacks der Gruppen angezeigt. Die GroBe der Anzeige
wird dabei automatisch an die Anzahl der enthaltenen Playbacks angepasst;
ggf. wird ein Scrollbalken eingeblendet. Mit dem Button [ + ] links unten
kann eine neue Gruppe angelegt, mit dem Stift (Edit-)Button eine bestehen-
de Gruppe editiert werden. Dabei kann man die zu editierende Gruppe ent-
weder numerisch auswahlen oder einfach im Playback Groups-Fenster ankli-
cken. Die gerade bearbeitete Gruppe wird dabei rot markiert. Klickt man im
Meni ,Edit Playback Group' auf das [ + ], so wird eine neue Gruppe mit den
angewahlten Playbacks angelegt.

Die Playback-Buttons im Fenster ‘Playback Groups’ sind jeweils Verknlpfun-
gen auf die eigentlichen Playbacks. Sie kdnnen wie gewohnt auch hier ange-
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klickt und gestartet/released/deaktiviert werden, es lasst sich auch hier die
Legende sowie die Playback-Optionen andern oder das Playback selbst editie-
ren. Wird Uber dieses Fenster ein Playback gestartet, das auf einem Fader
liegt, so wird es auf 100% gesetzt.

Playbacks, die in mehreren Playback-Gruppen sind, werden durch einen Stern
gekennzeichnet. Wird ein Playback in einer Gruppe gestartet, so werden
normalerweise alle anderen Playbacks in dieser Gruppe deaktiviert.

Driickt man auf <Record>, so wird bei jeder bestehenden Playback-Gruppe
ein [ + ] angezeigt. Klickt man darauf, so wird wie gewohnt ein neues Play-
back gespeichert und sowohl im Playbacks-Fenster (Speicherplatze) als auch
in diese Gruppe eingefligt. Auch <Copy> und <Move> sind hier mdglich.
Verschiebt man ein Playback von einer Gruppe zu einer anderen, so wird es
aus der alten entfernt und zur neuen hinzugefiligt, sofern es dort nicht bereits
mit enthalten ist. Wird ein Playback von auBerhalb des Fensters ,Playback
Groups' per <Move> hinzugefligt, so bleibt das Original-Playback an Ort und
Stelle erhalten und wird nur zusatzlich der Gruppe hinzugefligt. Driickt man
auf <Delete> und wahlt ein oder mehrere Playbacks im Fenster ,Playback
Groups', so 6ffnet sich das Menl ,Remove Playback from Playback Group'.
Hier kann man das Loschen mit [Remove playbacks from playback group x]
oder mit <Enter> bestatigen, um das/die Playbacks aus der Gruppe zu ent-
fernen.

Mit dem Reiter ,Options' unten rechts lassen sich verschiedene Optionen flr
die ausgewahlte Gruppe wahlen:

- ‘Mutually Exclusive' (Exklusiv) bestimmt, ob sich die Playbacks innerhalb
der Gruppe gegenseitig deaktivieren oder nicht. Vorgabewert ist ,On' (also
Exklusiv)

- 'Kill Point' (Ausschaltpunkt) bestimmt den Punkt, an dem ein Playback die
anderen Playbacks der Gruppe deaktiviert. Steht dies auf ‘Fired’, so wer-
den die anderen Playbacks bereits deaktiviert, sobald das neue nur ge-
startet wird. Steht die Option dagegen auf ,Fade Completed' (Einfaden
komplett), so werden die anderen Playbacks erst deaktiviert, wenn das
neue komplett eingefadet ist (sowohl der Fader ganz hoch als auch die
Fadezeit abgelaufen). Vorgabewert ist ,Fade Completed'.

- 'Kill Action' (Ausschalten) legt fest, wie genau die anderen Playbacks
deaktiviert werden. Steht dies auf ‘Follow Playbacks’, so gelten die Ein-
stellungen des jeweiligen Playbacks. Mit Kill' werden die anderen Play-
backs sofort deaktiviert. Steht die Option auf ,Release', so werden Play-
backs immer released, und bei ,Release HTP' werden HTP-Werte released
und LTP-Werte deaktiviert. Vorgabewert ist ,Follow Playback'.

- 'Release Mask' (Release-Maske) legt fest, welche Attribute released
werden. Klickt man darauf, so 6ffnet sich ein Popup sowie das Menl
'Playback Groups Release Mask'. Steht Mask Source auf ‘Playback’ (Vor-
gabewert), so wird die jeweilige Release-Maske jedes Playbacks verwen-
det. Andert man dies auf ,Local', so l&sst sich fiir jede Playback-Gruppe
eine eigene Release-Maske definieren, wobei man wie gewohnt einzelne
Attribute bzw. Attribut-Banke an- oder abwéhlen kann (Buttons im Popup
oder Attributbank-Tasten). Die Maske bleibt im Hintergrund erhalten,
auch wenn man Mask Source zwischen ,Local' und ,Playback' wechselt.

- 'Release Time' legt die Release-Zeit innerhalb der Gruppe fest (wenn
denn anhand der anderen Optionen released wird). Vorgabewert ist ,Play-
back’, und es werden die Release-Zeiten der Playbacks herangezogen;
man kann aber auch eine Release-Zeit pro Gruppe eingeben.

Auch fir dieses Fenster lasst sich Uber den Zahnrad-Button in der Titelleiste
des Fensters das Erscheinungsbild festlegen. ,Button Size' beeinflusst nur die
Buttons der Playbacks, ,Text Size' die SchriftgroBe der Playbacks und der
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Gruppen. AuBBerdem gibt es den Button [View Mode]. Steht dieser auf [View
Mode All] (Vorgabe), so werden alle Gruppen und neben jeder Gruppe alle
enthaltenen Playbacks angezeigt. Bei [View Mode Single] dagegen werden
zwar alle Gruppen, aber nur die Playbacks der gerade angewdhlten Playback-
Gruppe angezeigt. Und bei [View Mode Playbacks Only] werden nur die Play-
backs angezeigt, die linke Gruppen-Spalte dagegen wird ausgeblendet. In
diesem Modus lassen sich Playback-Gruppen in diesem Fenster nicht anwah-
len (allerdings nach wie vor im Playback Groups-Meni), und auch die Reiter
unten sind ausgeblendet. Wie gewohnt werden die Anzeigeeinstellungen mit
in den Workspace (Arbeitsumgebungen) abgespeichert.

2. Pioneer D] BPM-Trigger

Es ist nun mdglich, verschiedene Decks der Pioneer DJ-Serie zum Steuern
der BPM-Master zu verwenden. Die verwendeten Gerate muissen dabei die
Pioneer Pro DJ Link Bridge unterstitzen, wie etwa das CDJ-2000NXS2.

Um diese Funktion nutzen zu kénnen, muss das Programm ,Pro DJ Link
Bridge' gestartet werden. Auf Titan-Pulten findet man dies in Tools > Additi-
onal Programs. Wenn erforderlich lasst sich dies mit Tools - Control Panel >
Run on Startup - Pro DJ Link Bridge automatisch starten, sobald das Pult
gestartet wird. Bei der PC-Suite wird das Programm unter Start > Pro D]
Link Bridge - Pro DJ Link Bridge installiert.

Die Pioneer-Gerate gestatten keine explizite Netzwerk-Konfiguration. Es ist
vielmehr ein DHCP-Server oder eine automatische Adressvergabe per mDNS
erforderlich, zu erkennen and einer automatischen Adresse wie 169.254.* *
Bei Pulten kann man die entsprechende Netzwerkschnittstelle auf DHCP set-
zen, muss aber sicherstellen, dass diese flr nichts anderes verwendet wird
und z.B. Art-Net oder sACN Uber einen anderen Netzwerkanschluss laufen.

Jedes im Netzwerk gefundene kompatible Pioneer-Gerat wird mit der jeweili-
gen Modellbezeichnung im Pro DJ Link Bridge-Fenster angezeigt. Tauchen
hier keine Gerate auf, ist moéglicherweise die falsche Netzwerkschnittstelle in
Pro D] Link bzw. TC Net ausgewahlt.

Sind kompatible Gerate richtig verbunden, so kénnen diese als Trigger flr
BPM-Master definiert werden. Dazu legt man zunachst einen BPM-Master an.
Das Definieren des Triggers erfolgt dann wie gewohnt Gber <Avo>+<Disk>,
[Triggers], [Add New], {Namen eingeben}, [OK], [Add Trigger], [Trigger Ty-
pe Item], {BPM-Master wahlen}. Aktuell ist [Pioneer D]] die einzige angebo-
tene Trigger-Aktion fiir BPM-Master. Als nachstes drickt man wieder auf
[OK]. Zunéchst ist das ,Master'-Deck die BPM-Quelle, jedoch kann man mit
[Deck] auch ein anderes auswahlen. Mit [Add] wird schlieBlich der Trigger
angelegt, und das gewahlte Deck steuert den BPM-Master.

Es gibt dazu ein vordefiniertes Macro ,Pioneer D] On/Off'. Damit lasst sich die
Steuerung per Pioneer Pro D] Link komfortabel aktivieren oder deaktivieren,
um den BPM-Master manuell zu steuern.

Geht ein als Trigger definiertes Gerat im Betrieb verloren, z.B. durch eine un-
terbrochene Netzwerkverbindung, so erscheint im Dialog-Bereich die War-
nung ,CDJ bound to BPM master lost. Touch here to clear this warning.'

3. PioneerDJ]-Fenster

Es gibt ein neues Fenster ,PioneerD]'. Damit lassen sich genaue Informatio-
nen zu laufenden Tracks auf per Pro DJ Link Bridge verbundenen kompatiblen
Geraten anzeigen, das Master-Deck wahlen sowie BPM-Trigger aktivieren und
deaktivieren.

Geoffnet wird dieses Fenster wie gewohnt mit [Open Workspace Window] >
[PioneerD]]. Im unteren Bereich des Fensters werden alle im Netzwerk vor-
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handene Gerate griin angezeigt, und dort gibt es auch den Schalter zum Ak-
tivieren/Deaktivieren der BPM-Trigger. Es gibt Informationen Uber den gera-
de laufenden Track (Titel und Interpret), groBe und kleine Darstellungen des
Signalverlaufs mit Anzeige der aktuellen Position, den Wiedergabestatus
(Stop/Pause/Play) sowie die aktuelle und die noch verbleibende Laufzeit des
Tracks. Der aktuelle Master wird durch ein rotes [M] markiert; klickt man bei
einem anderen Gerat auf [M], so wird dieses der Master.

Im Kontext-Bereich lassen sich verschiedene Anzeigeoptionen einstellen:

- 'Big Waveform Shown/Hidden' legt fest, ob die groBe Darstellung des Sig-
nalverlaufs angezeigt wird (Vorgabewert: shown - angezeigt)

- 'Small Waveform Shown/Hidden' legt fest, ob die kleine Darstellung des
Signalverlaufs angezeigt wird (Vorgabewert: shown — angezeigt)

- 'Track Details Shown/Hidden' bestimmt, ob Titel und Interpret angezeigt
werden (Vorgabe: shown - angezeigt)

- 'Status Bar Show n/Hidden' bestimmt die Anzeige der unteren Statusleis-
te (Vorgabe: shown - angezeigt)

- Mit'Zoom’ lasst sich die GréBe der groBen Signaldarstellung einstellen, in
Schritten von 10%, 25%, 50%, 75% oder 100%. Dies ist identisch mit
den Zoom-Optionen der ProDJ]-Gerate; Vorgabewert ist 100%.

- Wahlt man ‘Change Layout’, so 6ffnet sich ein Untermen( ‘PioneerD] Lay-
out mit folgenden Optionen:

o ,Full': Anzeige aller Informationen fir alle verbundenen Gerate

o ,Master': Anzeige der gewdhlten Informationen nur fiir den ge-
wahlten Master

o ,Condensed': Anzeige der gewahlten Informationen fiir den ge-
wahlten Master, die BPM-Werte und den BPM-Schalter sowie die
Track-Details der anderen Gerate.

Mittels [Assign Triggers] gelangt man zum Trigger-Mend.

Hinweis: damit der Signalverlauf und die verstrichenen/verbleibenden Zeiten
korrekt dargestellt werden, missen die Tracks in RecordBox analysiert und
exportiert werden; die Pioneer-Gerate selbst machen das nicht und setzen
ebenfalls auf RecordBox.

Verbesserungen

1.

Mehr BPM-Master
Es gibt nun 8 statt 4 BPM-Master

Kompatibilitat von USB-MIDI

USB-MIDI ist nun zu mehr Geraten und Treibern anderer Hersteller kompati-
bel.

Behobene Fehler

1.

Winamp-Steuerung bei anderer Adresse als 1.001

Wurde Winamp auf eine andere Adresse als 1.001 gepatcht, so wurde Win-
amp selbst nicht ordnungsgemaB gesteuert. Das wurde behoben, so dass nun
egal ist, auf welcher Adresse Winamp gepatcht wird.

NDI-Streams nicht richtig geschlossen

NDI-Streams wurden etwa beim SchlieBen des ,Video Multi View'-Fensters
nicht ordnungsgemaB beendet, so dass bei wiederholtem Offnen und Schlie-
Ben des Fensters Qualitat und Performance einbrachen. Behoben.
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Titan und OpenSLP

Wurde Titan auf Computern mit OpenSLP eingesetzt, so konnte Titan nicht in
Sessions verwendet werden, da es nicht von anderen Computern gefunden
wurde. Korrigiert.

Bekannte Probleme

1.

Version 12.1 wird durch ein v12.0 Factory Restore geloscht

Fihrt man auf einem Pult mit Version 12.1 ein v12.0 Recovery aus und wahlt
,Factory Restore', so wird nicht Version 12.1 zurlickgesetzt, sondern auf 12.0
zuriickgegangen. Um dies zu umgehen, fithrt man entweder eine ,Standard
Recovery' aus oder installiert Version 12.1 manuell nach dem Factory
Restore.

PC-Suite und das CodeMeter WebAdmin Interface

Nach der Installation der PC Suite ist das CodeMeter WebAdmin Interface
nicht mehr erreichbar. Zum Beheben installieren Sie bitte die CodeMeter
Runtime nach der Titan PC-Suite.

Kein Downgrade auf dltere Versionen

Versucht man nach der Installation von Titan Version 12 mit einem der Up-
grade Installer auf eine altere Version zurlickzugehen, so ist das nicht még-
lich, und das Pult wird nicht starten. Muss man ein Pult auf eine altere Versi-
on bringen, so geht das nur mit einem entsprechenden Recovery Stick. Ist
bereits ein Versuch fehlgeschlagen, so muss die Option ,Full Erase*' gewahlt
werden. Dabei kann die vorher vorhandene Lizenz weiter verwendet werden.

AuBerdem ist es erforderlich, bei allen Pulten mit Sapphire-DMX-Panels (ST-
DMX - dies betrifft das Sapphire Touch, TNPs, Tiger Touch II und das Arena)
deren Firmware ebenfalls downzugraden. Grund daflr ist, dass die neuere
Firmware nicht mit der alteren Titan-Software kompatibel ist. Zum
Donwgrade der Firmware 6ffnet man die USB Expert Console, kliickt links auf
das betreffende Panel und dann rechts im Reiter ,Service' auf [Enter Boot].
Taucht das Panel wieder im Boot-Modus auf, wahlt man es erneut aus und
klickt auf [Program]. In der erscheinenden Maske navigiert man zum Ordner
C:\Program Files (x86)\Avolites\UsbExpert\Panel Software und wahlt die Da-
tei st_dmx.bin, um die friihere Firmware zu laden. Dies wiederholt man ggf.
flr jedes weitere ST-DMX-Panel. Sind alle Panels umprogrammiert und wie-
der aus dem Boot-Modus heraus, so ist das Pult neu zu starten und kann mit
der dlteren Software verwendet werden. Sobald man wieder Titan Version 12
installiert, ist auch wieder ein Panel Update durchzuftihren.

Touchscreen funktioniert falschherum

Mitunter sorgt die ,Touchscreen Calibration' Funktion beim Tiger Touch II da-
flr, dass der Touchscreen 190° gedreht arbeitet. Aktuell sollte man beim Ti-
ger Touch II die Kalibrierung nicht nutzen.

Tritt dies bereits auf, so ist die momentane Abhilfe, die Kalibrierung durchzu-
fihren und jeweils auf die entgegengesetzte Ecke zu klicken, damit im Er-
gebnis der Touchscreen wieder richtig funktioniert.

Chase-Cuenummern griin

Schaltet man die Benutzereinstellung ,Chase Snap' aus und 6ffnet dann einen
Chaser in der Playback-Ansicht, so werden alle Cues griin angezeigt zum Zei-
chen, dass sie gerade aktiv sind.

Safe Mode bei unterbrochener Netzwerk-Session

Wenn bei Sessions mit TNPs und mehreren Pulten das Masterpult die Verbin-
dung verliert, ein Backup-Pult Gbernimmt und danach der Master wieder
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10.

11.

12,

13.

14.

15.

16.

17.

Ubernehmen soll, kann es dazu kommen, dass der Master im Safe Mode han-
genbleibt.

Externer Touchscreen und TNP

SchlieBt man einen externen Touchscreen an einen TNP mit einem LV67H
Motherboard an, so werden die beiden Touchscreens nicht richtig zugeordnet,
und arbeiten entsprechend falsch.

Titan Remote auf Android

Aufgrund eines Fehlers im Android-System kdnnen einige neuere Android-
Gerate keine Titan-Session im Netzwerk finden oder aber wahrend der Be-
nutzung die Verbindung verlieren. Eine Anleitung, um dies zu beheben, ha-
ben wir als FAQ 10035 auf https://www.avolites.com/support/titan-
troubleshooting verdéffentlicht. Mehr Informationen Uber diesen Fehler, den
wir an Google gemeldet haben, findet man hier:
https://issuetracker.google.com/issues/132686258

Remote stiirzt bei groBeren Shows gelegentlich ab

Aufgrund eines Fehler in der internen Kommunikation kann es bei gréBeren
Shows vorkommen, dass die Titan Remote bei Start oder wahrend der Ver-
wendung abstirzt. Obwohl vieles unternommen und verbessert wurde, kann
dies trotzdem noch gelegentlich vorkommen. Ein Neustart der Remote er-
maoglicht das Weiterarbeiten.

Ai und die Titan PC-Suite auf dem gleichen Computer

Es ist nicht mdglich, Ai und die Titan PC Suite auf dem gleichen Rechner in
einer Synergy-Session zu benutzen.

Ausgadnge stocken kurz

Unter groBer Last kann es vorkommen, dass die DMX-Ausgange kurz sto-
cken.

Synergy Lightmap zeigt darunterliegende Farbe

Unter groBer Rechenlast kann es vorkommen, dass bei Verwendung von Sy-
nergy Lightmap gelegentlich die darunterliegernde ,normale' Farbe der Fix-
tures ,durchkommt'.

Synergy-Multiview startet Streams neu bei Wechsel des
Bildschirms

Wird das Fenster ,Synergy Multiview' auf ein anderes Display verschoben, so
muissen die NDI-Streams neu synchronisiert werden, was ein paar Sekunden
dauern kann.

Kein MID wahrend der Link-Offset-Zeit

Move In Dark erfolgt nicht wahrend der Link-Offset-Zeit von automatisch
nacheinander startenden Cues.

Riickgangigmachen im Programmer released Quick Palettes
Werden Anderungen im Programmer per Undo riickgéngig gemacht, so wer-
den auch alle per Quick Palette vorgenommenen Einstellungen entfernt.
Fade-In bei Pixelmapper-Effekten in einzelnen Cues
Pixelmapper-Effekte in Einzelcues berlcksichtigen nicht die eingestellte Fade-
In-Zeit.

Layout Editor, Arrange Fixtures, scheitert bei manchen Geraten

Die automatische Anordnung per Arrange Fixtures im Layout Editor funktio-
niert bei einigen Geratetypen nicht, wenn diese im Dreieck angeordnet wer-
den sollen.


https://www.avolites.com/support/titan-troubleshooting
https://www.avolites.com/support/titan-troubleshooting
https://issuetracker.google.com/issues/132686258
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18. Tastenprofil ,Go' tastet Lampen kurz dunkel

Ist flr einen Einzelcue das Tastenprofil auf ,Go' gesetzt und eine Fade-In-zeit
eingestellt, so werden wird beim Betatigen der Taste die betreffenden Gerate
erst dunkel und faden dann auf den neuen Wert, statt nahtlos von der vori-
gen auf die neue Einstellung lGberzublenden.

19. PioneerD] erfordert mitunter einen Neustart

Beim Offnen des PioneerD]-Fensters werden gelegentlich die Signalkurven
nicht dargestellt. Tritt dies auf, obwohl die Bridge-Software ordnungsgeman
lauft, so hat Titan die Verbindung zur Bridge nicht gefunden. Um dies zu be-
heben, ist ein Neustart der Titan-Software erforderlich.
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